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About the JUNO-Gi Workshop Booklets

The Roland JUNO-Gi Mobile Synthesizer with Digital Recorder is an 
affordable, portable, perfect instrument for performers and songwriters. 
It’s got a top-of-the-line sound engine and over 1300 exciting new sounds. 
The onboard digital recorder allows you to record and develop your songs, 
with dedicated faders and acclaimed BOSS GT-class effects. With USB MIDI 
capabilities and its instant MIDI Controller mode, the JUNO-Gi also fits nicely 
into any computer-based recording system. Finally, the JUNO-Gi sports a 
versatile USB song player for playing backing tracks onstage.

Each JUNO-Gi Workshop Series booklet focuses on one JUNO-Gi topic, and is 
intended as a companion to the JUNO-Gi Owner’s Manual.

This booklet requires JUNO-Gi Operating System v1.01 or higher. You can 
download the latest JUNO-Gi O.S. for free from www.RolandUS.com.

About This Booklet

As a modern instrument, the JUNO-Gi is designed for use with a computer-
based recording system’s digital audio workstation, or “DAW.” This booklet 
describes how to place the JUNO-Gi at the center of a DAW-based system.

Understanding the Symbols in This Booklet

Throughout this booklet, you’ll come across information that deserves 
special attention—that’s the reason it’s labeled with one of the following 
symbols.

A note is something that adds information about the topic at hand.

A tip offers suggestions for using the feature being discussed.

Warnings contain important information that can help you avoid 
possible damage to your equipment, your data, or yourself.

The Possibilities

After you’ve installed the driver software that ships with the JUNO-Gi, the 
JUNO-Gi can play three important roles in creating music on your computer:

• The JUNO-Gi can act as your DAW’s audio interface 

• The JUNO-Gi can be your DAW’s MIDI controller

• You can use the JUNO-Gi’s sounds with your DAW

We’ll assume you know how to use your computer and DAW software. If 
you need help, please consult the software’s documentation.

The JUNO-Gi as Your Audio Interface

Live audio...

U
S
B 

...is recorded in the DAW. Hear the DAW’s audio output...

U
S
B 

...through the JUNO-Gi. 

One of the most important pieces of equipment you need to purchase and 
add to your computer when setting up a DAW system is a device to which 
you can connect your mics and instruments in order to get their sounds into 
your computer. Likewise, the device provides a way to properly listen to your 
DAW’s audio outputs. This device is your “audio interface.”

The JUNO-Gi spares you from having to purchase one since it can do the job 
itself as the 44.1 kHz, 16-bit audio interface for your DAW.

http://www.rolandus.com/products/productdetails.php?ProductId=1126&tab=downloads&skip=true
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The JUNO-Gi as a Sound Module

MIDI notes...

U
S
B 

...are captured in the DAW. Notes are sent to JUNO-Gi...

U
S
B 

...where they play notes.

In MIDI Controller mode, you can use the JUNO-Gi as a “multitimbral” sound 
module, playing up to 16 of its tones and rhythms at once via MIDI from a 
DAW. Since the JUNO-Gi also acts as a master MIDI controller, you can use 
its keyboard for sequencing the DAW MIDI tracks that play the JUNO-Gi’s 
sounds.

You can also play General MIDI files on your computer and use the JUNO-Gi’s 
built-in General MIDI 2 tones as its sounds.

If you’d like to know more about MIDI and/or General MIDI, see our 
InFocus booklet, An Introduction to MIDI, which you can download 
here.

Of course, you can use another MIDI controller—such as a Roland 
OCTAPAD® SPD-30 digital percussion pad or other keyboard controller—
if you prefer.

When you use the JUNO-Gi as a sound module, you can send its output to 
audio tracks in your DAW for recording via the same USB connection you use 
for MIDI communication.

As your interface, the JUNO-Gi’s USB connection simultaneously

• feeds audio digitally to your DAW, including

• its own sounds—such as its live sets when you’re playing the 
JUNO-Gi, or up to 16 tones or rhythms in MIDI Controller mode.

• live audio from instruments or mics connected to its rear-panel 
jacks—as described in the Using the JUNO-Gi’s Live Audio Inputs 
and BOSS Effects Workshop booklet. You can download the 
booklet by clicking here.

• carries the entire stereo audio output of your DAW digitally back to the 
JUNO-Gi—so you can hear its audio tracks, soft synths, and so on, along 
with the JUNO-Gi’s sounds, through the JUNO-Gi’s audio outputs or 
headphones plugged into the JUNO-Gi’s PHONES jack.

The JUNO-Gi as Your MIDI Controller

MIDI notes...

U
S
B 

...are captured in the DAW.

In its easy-to-use MIDI Controller mode, the JUNO-Gi can act as the master 
controller for your DAW system. Play the DAW’s soft synths from the 
JUNO-Gi and shape their sound in realtime using the JUNO-Gi’s knobs, 
sliders, and buttons. The JUNO-Gi can also play sounds in any external MIDI 
device connected to your computer (including itself ).

We’ll discuss MIDI Controller mode in “Using the JUNO-Gi as a Master MIDI 
Controller” on page 7.

http://cms.rolandus.com/assets/media/pdf/INFOCUS01_MIDI.pdf
http://cms.rolandus.com/assets/media/pdf/JUNOGiWS03.pdf
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Installing the JUNO-Gi Drivers on Your Computer

The JUNO-Gi drivers enable the passing of sounds and MIDI messages 
between the JUNO-Gi and your computer using a single USB cable.

You can find the driver software you need for your JUNO-Gi on the JUNO-Gi 
DRIVER CD-ROM that shipped with your JUNO-Gi, or download the latest 
version for your operating system from here.

After installing the drivers, you’ll need to restart your computer.

Installing the JUNO-Gi Drivers in Windows 7

If you’re installing the drivers for Windows XP or Vista, please see the 
instructions accompanying the installer files.

Throughout the installation process, Windows 7 may ask you to allow 
the installer to change your computer. Click Yes to continue.

1 Power up your PC with all USB cables disconnected except for your 
keyboard and mouse. If any applications are running, quit them.

2 Begin by

• locating the driver software on the JUNO-Gi CD-ROM—and 
opening the Driver folder, and then the Windows 7 folder.

• downloading the JUNO-Gi USB Drivers Windows 7 32-bit or 64-bit 
software—from here.

To find out if you’re running Windows 7 32-bit or 64-bit, go to the Start 
menu, click Control Panel, then System Security, and then System. For 
System Type, you’ll see “32-bit” or “64-bit Operating System.”

When you download the installer, save it to your desktop without 
opening it. Then, right-click the downloaded file and select Extract 
All..., choosing the Desktop as the extraction destination. You’ll find 
the installer file in the resulting folder.

Getting Ready

Connecting the JUNO-Gi Via USB to Your Computer

You’ll connect the JUNO-Gi to your computer using a standard USB A/B 
cable.

A-type plug

B-type plug

If your computer is running

• Windows—you’ll be instructed to connect the JUNO-Gi to your 
computer as part of the driver installation process. Please don’t connect 
it until instructed to do so.

• Mac OS X—you can connect the JUNO-Gi via USB to your computer 
before or after driver installation.

Here’s how to connect the JUNO-Gi to your computer:

1 Connect the B end of the USB cable to the JUNO-Gi’s rear-panel USB 
COMPUTER jack.

Connect B plug here.

2 Connect the A-plug end of the cable to a USB port on your computer.

When you connect the JUNO-Gi to your computer via USB, you’ll 
typically get the best results using USB jacks on the back of a desktop 
computer or on the side of a laptop. We recommend not using a hub.

http://www.rolandus.com/products/productdetails.php?ProductId=1126&tab=downloads&skip=true
http://www.rolandus.com/products/productdetails.php?ProductId=1126&tab=downloads&skip=true
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7 Windows 7 presents a window instructing you to

• make sure the JUNO-Gi is turned off—and then

• connect the JUNO-Gi via USB to your computer—as we described 
on page 4, and then turn it on.

Once you do these things, the JUNO-Gi drivers are installed.

8 Click the Close button and you’re ready to go.

Installing JUNO-Gi Drivers in Mac OS X

You can use your JUNO-Gi with a computer running Mac OS X 10.6, 
10.5, and 10.4.

You can install the JUNO-Gi driver software with the JUNO-Gi already 
connected via USB to your Mac via, or not.

1 Begin by

• locating the driver software on the JUNO-Gi CD-ROM—by opening 
the Driver folder, and then the folder for the version of Mac OS 
X you’re using.

• downloading the JUNO-Gi driver software—from here. If you’re 
using Mac OS X 10.6 (Snow Leopard), click JUNO-Gi USB Drivers 
Mac OS 10.6. If you’re using Mac OS X 10.4 or 10.5, click JUNO-Gi 
USB Drivers Mac OS 10.5 and Earlier. Once you’ve downloaded 
the necessary file to your Download folder, double click its folder 
to reveal the installer file.

2 Double-click the installer file to launch the driver installer. If you’re 
using

• Mac OS 10.6—double-click the JUNOGi_USBDriver.pkg file.

• Mac OS 10.5 or 10.4—double-click the JUNOGiUSBDriver.pkg file.

When the installer launches, the computer may display a message 
about verifying that your computer can use the JUNO-Gi driver.

3 If you see this message, click Continue to display the installer’s 
Introduction screen that lets you confirm you have the correct 
installer for your version of Mac OS X.

3 Double-click the JUNO-Gi USB MIDI Setup file to display the following 
window:

4 Click Next to display the installation start window:

5 Click Next—Windows 7 begin to install the driver, and asks if you 
wish to complete the process.

6 Checkmark Always trust software from “Roland Corporation”, and 
then click Install to proceed.

http://www.rolandus.com/products/productdetails.php?ProductId=1126&tab=downloads&skip=true
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If your Mac displays a message about reboot caches, click OK.

8 After you restart, connect your JUNO-Gi via USB if it isn’t already 
connected, and power it up.

The JUNO-Gi’s Audio Interface

When you want the DAW to record a live set you’re playing on the JUNO-Gi, 
and/or live audio, you can control what gets sent to the DAW. Here’s how:

1 On the JUNO-Gi, press MENU to display the Top Menu window.

2 Select System, and then press ENTER.

3 Press 1 (GENERAL).

4 Press 6 to select the USB Audio to Computer value.

You can set it to

• MIX—so the JUNO-Gi sends both its live-set sound and live 
audio to the DAW.

• INPUT—so the JUNO-Gi sends only live audio dry, without 
effects.

• INPUT FX—so the JUNO-Gi sends live audio along with any of the 
JUNO-Gi’s built-in BOSS input effects you’re using.

5 Select the option you want, and then press EXIT.

When you’re in MIDI Controller mode and the DAW is playing JUNO-Gi 
tones and rhythms, only those tones and rhythms are sent to the DAW, 
regardless of the USB Audio to Computer setting.

4 Click Install to view the Installation Type screen.

5 Click Install—the installer asks for your admin login and password.

6 Enter your admin login and password, and then press click OK.

The driver software is installed, and the installer informs you that you 
need to restart your Mac.

7 Click Restart.
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You can save your MIDI Controller mode setup 
in the JUNO-Gi’s memory at any time so your 
settings are instantly available when you 
enter the mode. To save your setup, press the 
JUNO-Gi’s WRITE button, as noted at the top-
right of the MIDI Controller mode screen.

MIDI Channel

The JUNO-Gi can transmit MIDI messages on any of the 16 MIDI channels to 
your DAW. By default, it uses MIDI Channel 1, though you can change it to 
any MIDI channel you like. Just make sure that the DAW is set to

• receive data on the same MIDI channel, or

• receive MIDI data on any and all channels.

Local Switch

The Local Switch setting—shown onscreen as “Local Sw”—sets whether 
the JUNO-Gi keyboard plays its own sounds in MIDI Controller mode or not. 
When your DAW’s using JUNO-Gi sounds, leave this set to Off, since you’ll 
play its sounds through the DAW. If you turn Local Sw on when using the 
JUNO-Gi as both the DAW’s master controller and sound module, you’ll hear 
each JUNO-Gi note twice, once from the DAW and once from the JUNO-Gi.

Important JUNO-Gi MIDI Stuff

One MIDI device communicates with another MIDI device using a series of 
MIDI messages, as explained in the InFocus booklet An Introduction to MIDI. 
The JUNO-Gi uses these messages when you’re using it as a

• a DAW’s master MIDI controller—In this role, the JUNO-Gi sends your 
computer note-event messages as you play the JUNO-Gi keyboard. 
In addition, many of its front-panel controls can send Control Change 
messages to your DAW that let you manipulate sounds in realtime. It 
can also send sound-selection messages that you can sequence in a 
DAW MIDI track—when the track is played back, it can send out these 
messages to external devices like the JUNO-Gi, or other connected MIDI 
sound modules.

• multitimbral sound module—As a multitimbral sound module, the 
JUNO-Gi responds to note-event messages and Control Change 
messages. Your DAW can also select the JUNO-Gi sounds you want by 
sending the JUNO-Gi Bank Select and Program Change messages. We’ll 
discuss these more later.

Using the JUNO-Gi as a Master MIDI Controller

Life In MIDI Controller Mode

Once you’ve installed its drivers, connected to your computer via USB, and 
your computer and JUNO-Gi are powered up, switch the JUNO-Gi into MIDI 
Controller mode to use it as your DAW’s master MIDI controller. (You also use 
MIDI Controller mode when you’re playing JUNO-Gi tones from your DAW.)

Press the MIDI CTRL (for “CONTROL”) 
button on the JUNO-Gi to display the MIDI 
Controller mode screen.

 

This screen determines the behavior of 
the JUNO-Gi in MIDI Controller mode, with 
some important settings and features.

http://cms.rolandus.com/assets/media/pdf/INFOCUS01_MIDI.pdf
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Each of the buttons, knobs, and faders shown in blue above can transmit a 
MIDI Control Change value to your DAW.

To program any of them, touch or move it, and its currently assigned MIDI 
message is displayed at the bottom of the screen. Highlight the control’s 
current setting, and select the MIDI message you want it to transmit.

DAW-Specific Instructions

For the rest of this booklet, we’ll walk you through the details of using the 
JUNO-Gi with some popular DAWs. (Teaching you how to use your DAW in 
general is beyond the scope of this booklet, of course.)

We’ll be showing you how to use the JUNO-Gi with

• Cakewalk by Roland SONAR X1 LE and SONAR Essential, Studio, and 
Producer—on page 9. (The steps for using the JUNO-Gi with SONAR 8.5 
LE are similar; only the menu and parameter locations have changed.)

• Apple Logic Pro 9—on page 13.

• Ableton Live—on page 16.

You can jump to the section on your DAW by clicking its page number 
above.

We’re going to assume you’ve installed the JUNO-Gi’s USB drivers 
on your computer, that you’ve got the JUNO-Gi connected to your 
computer and powered up, and that your DAW is launched.

Your DAW may allow you to use more than one audio interface, MIDI 
controller, and/or sound module—we’ll be describing how to use just 
the JUNO-Gi for these purposes. If you’re an advanced DAW user, you 
can build upon these instruction if you want to use multiple devices.

Sound-Selection Trigger

When you press one of the JUNO-Gi’s 0-9 category buttons in MIDI Controller 
mode, the button fires off the three MIDI messages required to select sounds 
in an external MIDI sound module you’re controlling from the JUNO-Gi. 
Though we’re talking about using the JUNO-Gi with a DAW, these messages 
are still important, and are sent between MIDI devices in this order:

1 a Bank Select MSB (for “Most Signficant Bit”) value

2 a Bank Select LSB (for “Least Significant Bit”) value

3 a Program Change Value

 

The values are presented 
in a different order on 
the JUNO-Gi display.

In some MIDI devices and software, Bank MSB and LSB messages are 
referred to as “CC00” and “CC32” messages, respectively. You can 
learn more about MSB and LSB messages in An Introduction to MIDI.

In the middle of the screen are the settings for one of the 0-9 buttons. 
(Button 1 is selected in the screenshot above.) To select a different 0-9 
button, touch the button—the screen updates to show you the button’s 
current Bank Select and Program Change buttons.

You can assign different Bank Select MSB, LSB, and Program Change values 
to the currently displayed button by highlighting each setting in turn and 
selecting the desired value.

Realtime Controller Setup
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7 Click Apply.

8 Click Playback and Recording at the left of the window and select 
ASIO from the Driver Mode popup like so:

9 Click Apply.

If you didn’t see the JUNO-Gi in the Devices pane earlier, click Devices 
now, and make sure only IN (JUNO-Gi) and OUT (JUNO-Gi) are checked.

10 If you want to use the JUNO-Gi as your master controller or use its 
tones, leave the Preferences window open for the next section of this 
booklet. If not, click Close.

SONAR X1 LE and SONAR X1 and the JUNO-Gi

Setting Up SONAR X1 LE and SONAR X1

Selecting the JUNO-Gi as Your Audio 
Interface

Whether you’re using SONAR X1 LE or a version of SONAR X1, the method for 
setting up the JUNO-Gi as your audio interface is the same.

1 From the Edit menu, select Preferences... .

2 Click the Basic button in the lower left of the Preferences window.

3 Click Devices in the Audio section at the left of the screen if it’s not 
already highlighted.

4 Un-check all of the available Input Driver and Output Driver 
checkboxes except for IN (JUNO-Gi) and OUT (JUNO-G).

 

If you don’t see the 
JUNO-Gi on this 
screen, jump to Step 
8, and then come 
back here.

At some point in the setup process, Windows may automatically check 
the audio interface’s specs.

5 Click Apply.

6 Click Driver Settings, and set Playback Timing Master to 1: JUNO-Gi 
OUT and Record Timing Master to 1: JUNO-Gi IN.
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5 When the Define Instrument Names window opens, click Import...

6 Navigate to the junogi_ins folder, and open it.

7 Select the JUNO-Gi_Tone+GM2.ins file, and click Open.

8 In the Import Instrument Definitions window, make sure Roland 
JUNO-Gi: Tone is selected, and click OK.

Selecting the JUNO-Gi as a MIDI Controller

Here’s how to set SONAR to exchange MIDI messages with the JUNO-Gi.

1 Click Devices in the MIDI area at the left of the Preferences window. 
(If the Preferences window’s not yet open, select Preferences... from 
the Edit menu.)

2 In the Inputs and Outputs areas, make sure that the JUNO-Gi’s boxes 
are checkmarked.

3 Click Apply.

4 If you want to use JUNO-Gi tones with your DAW, leave the Preferences 
window open for the next section. If not, click Close.

Enabling Simple JUNO-Gi Tone and Rhythm Selection

1 Using your browser, click this link and download the JUNO-Gi 
Cakewalk SONAR Instrument Definition List file to your desktop.

2 Right-click the file and choose Extract All..., selecting the Desktop as 
your destination. This creates the junogi_ins folder.

3 Back in SONAR’s Preferences window, click Instruments in the MIDI 
area at the left. (If the window’s not open, select Preferences... from 
the Edit menu first.)

4 Click the Define... button, circled in red below.

http://www.rolandus.com/products/productdetails.php?ProductId=1126&tab=downloads&skip=true
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Using the JUNO-Gi with SONAR X1 LE and SONAR X1

The JUNO-Gi as SONAR’s Audio Interface

Listening to SONAR Through the JUNO-Gi

Once you’ve got the JUNO-Gi configured as SONAR’s audio interface, you 
can listen to SONAR

• through your speakers—by connecting the JUNO-Gi’s L/MONO and R 
OUTPUT jacks to your mixer, powered speakers, or amplifier.

• through headphones—by plugging your headphones into the
JUNO-Gi’s PHONES jack.

In both cases, the JUNO-Gi’s VOLUME knob controls 
your listening level.

If you can’t hear SONAR at all through the JUNO-Gi, 
select the SONAR Master channel strip and check to 
make sure JUNO-Gi OUT is selected as its output.

Setting Up an Audio Track for Recording 
From the JUNO-Gi

1 In SONAR X1 LE or SONAR X1, create an audio 
track or select one that’s not in use.

2 Make sure the audio track’s Input Echo button 
is turned off since you’ll be listening to your live 
audio through the JUNO-Gi to avoid a timing lag, 
or “latency.”

3 Click the Input popup and select Stereo JUNO-Gi IN.

Input popup menu

9 Repeat Steps 4-8, this time selecting the JUNO-Gi_Rhythm+GM2.ins 
file in Step 7 and Roland JUNO-Gi: Rhythm in Step 8.

10 Back in the Preferences windows’ Instruments pane, select all of the 
JUNO-Gi’s outputs in the left-hand box.

11 Control-click JUNO-Gi / 10 to de-select it.

12 In the right-hand box, select Roland JUNO-Gi: Tone.

13 Click JUNO-Gi / 10 so it’s the only output selected.

14 In the right-hand box, select Roland JUNO-Gi: Rhythm.

15 Checkmark the Save Changes for Next Session box so you don’t have 
to import the JUNO-Gi definitions each time you start a new project.

16 Click Apply, and then click Close.

Output popup menu
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Choosing the JUNO-Gi Tone or Rhythm You Want

You use three popup menus in the middle of a MIDI track’s channel strip in 
setting up the track prior to sequencing.

Channel popup
Bank popup

Patch popup

Each of the JUNO-Gi’s 16 possible tones or rhythms is played by one of the 16 
available MIDI channels. If you want each MIDI track to play its own sound, it 
has to be the only one using this MIDI channel.

1 Click the Channel popup and select a channel for the MIDI track to 
use.

As we’ve got SONAR configured, select 10: Roland JUNO-Gi:Rhythm if 
you want to use one of the JUNO-Gi’s drum or percussion kits.

If you do want multiple MIDI tracks to use the same tone or rhythm, set 
them to use the same part.

It can be handy to have a list of the available tones and rhythms on 
hand as you select your sounds. For a PDF of this list, click here and 
download the JUNO-Gi Patch/Performance List.

2 Click the Bank popup and select the bank in the JUNO-Gi that 
contains the tone or rhythm you want the MIDI track to play.

3 Click the Patch popup and select the desired tone or rhythm.

If the JUNO-Gi’s in MIDI Controller mode, the MIDI track’s now ready 
to sequence using one of the JUNO-Gi’s tones or rhythms.

You can create a SONAR project template with your favorite JUNO-Gi 
tones and rhythms to save setup time when you start a new project.

We’ve selected the JUNO-Gi’s stereo output, the most common thing 
to do. If you prefer, you can record either the left or ride side of its 
stereo output as a mono track instead. With two mono tones panned 
left and right within the JUNO-Gi, this is a good way to simultaneously 
record them on separate tracks. It’s also a good way to record a mono 
track of live audio.

4 Click the Output popup and select MASTER so the track’s output 
goes to the to SONAR’s Master outputs, or to the desired bus if you’re 
grouping the audio track with others on a bus.

Output popup menu

The JUNO-Gi as SONAR’s Controller and Sound Module

In SONAR, you use a MIDI track when you want to sequence using the 
JUNO-Gi as your master controller, or use its tones and rhythms. Begin by 
creating a new MIDI track, or selecting one that’s not already in use.

Using the JUNO-Gi as Master MIDI Controller

As you set up for sequencing a new MIDI track:

1 Click the track’s Input popup menu.

2 Select

• MIDI Omni—to receive on any 
MIDI channel the JUNO-Gi uses.

• the specific MIDI channel—shown 
on the JUNO-Gi’s MIDI Controller 
mode screen, as described on 
page 7.

The Input popup menu

http://www.rolandus.com/products/productdetails.php?ProductId=1126&tab=support&skip=true
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Setting the Project’s Sample Rate

Each Logic Pro project you work on using the JUNO-Gi must use a 44.1 kHz 
sample rate. To change a project sample’s rate:

1 Click and hold down the Settings button in the 
Arrange window tool bar, and select Audio... to 
open the Project Settings window. (If you prefer, 
you can do the same thing from the File menu’s 
Project Settings sub-menu.)

2 Set the Sample Rate popup menu to 44.100 kHz.

3 Close the Project Settings window.

To avoid having to set your sample rate for each new project, consider 
saving a 44.1 kHz JUNO-Gi template project.

Enabling Simple JUNO-Gi Tone and Rhythm Selection

1 Using your browser, click this link and download the JUNO-Gi
Logic Pro Multi-Instrument file that contains the JUNO-Gi Tones and 
Rhythms project.

2 In Logic Pro, create a new project, or open the one with which you 
want to work.

If the JUNO-Gi is your only hardware synth—or if you’re new to Logic 
Pro—you can work directly in this project. Consider saving it as a 
template. Once you’ve loaded the project or a copy of it, jump ahead 
to Step 3 in “Choosing the JUNO-Gi Tone or Rhythm You Want” on page 
15 to learn how to choose its tones and rhythms.

Settings button

Logic Pro and the JUNO-Gi

Setting Up Logic Pro

Selecting the JUNO-Gi as Your Audio Interface

1 After you launch Logic Pro, click and hold down the Preferences 
button in the Arrange window tool bar, and select Audio... to open 
the Core Audio tab of the Preferences window. (If you prefer, you can 
do the same thing from the Logic Pro menu.) 

2 Set the Input and Output Device popup menus to JUNO-Gi 44.1kHz, 
and uncheck the 24-bit Recording and Software Monitoring boxes.

We’ll be listening to the JUNO-Gi and its live audio inputs through the 
JUNO-Gi. This is the best way to avoid any listening lag, or “latency.”

 

If the Core Audio 
tab—shown 
here—isn’t visible, 
click its tab.

3 If you had to make any changes in Step 2 above, click Apply Changes.

4 Close the Preferences window.

http://www.rolandus.com/support/downloads_updates/eula.php?FileName=juno-gi_logic_multi-instrument.zip
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Using Logic Pro with the JUNO-Gi

The JUNO-Gi as Logic Pro’s Audio Interface

Listening to Logic Pro Through the JUNO-Gi

Once you’ve got the JUNO-Gi configured as Logic Pro’s audio interface, you 
can listen to Logic Pro

• through your speakers—by connecting the JUNO-Gi’s L/MONO and R 
OUTPUT jacks to your mixer, powered speakers, or amplifier.

• through headphones—by plugging your headphones into the
JUNO-Gi’s PHONES jack.

In both cases, the JUNO-Gi’s VOLUME knob controls your listening level.

Setting Up an Audio Track for Recording From the JUNO-Gi

1 In the Arrange window, click the + button above the track list to 
create a new stereo audio track in Logic Pro, selecting Input 1-2 from 
the Input menu, and unchecking the Input Monitoring box.

2 Click Create to finish creating your audio track.

We’ve selected the JUNO-Gi’s stereo output. If you prefer, you can 
record either the left or ride side of its stereo output on a mono 
track instead by selecting Input 1 or 2, respectively. With two mono 
tones panned left and right within the JUNO-Gi, this is a good way to 
simultaneously record them on separate tracks. It’s also a good way to 
record a mono track of live audio.

3 Once the project’s open, select Open… from the File menu.

4 When Logic Pro asks you if you want to close the current project, click 
Don’t Close.

5 Navigate to the JUNO-Gi Tones and Rhythms project file, and then 
click Open.

6 Once the JUNO-Gi Tones and Rhythms project opens, select 
Environment from the Window menu.

7 Select MIDI Instruments or MIDI Instr. from the Environment window’s 
Layer popup menu.

8 Click on the JUNO-Gi Library multi-instrument by clicking its icon, as 
shown here.

9 Select Copy from the Edit menu, and close the Environment window.

10 Close the JUNO-Gi Tones and Rhythms project—when Logic Pro asks 
you if you want to save any changes you’ve made, click Don’t Save.

This puts you back in the project you created or opened in Step 2. 
(Logic Pro pauses to reload any audio the project needs.)

11 Select Environment from the Window menu.

12 Select MIDI Instruments or MIDI Instr. from the Layer popup menu.

13 Select Paste from the Edit menu to add the JUNO-Gi Library multi-
instrument to this project, and then close the Environment window.
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Choosing the JUNO-Gi Tone or Rhythm You Want

Here’s how to get your Logic Pro track to automatically select the JUNO-Gi 
tone or rhythm you want each time you play your project.

You may want to have a list of the available tones and rhythms on 
hand as you select your sounds. For a PDF of this list, click here and 
download the JUNO-Gi Patch/Performance List.

1 After creating your External MIDI track in the 
Arrange window, make sure its MIDI parameters 
are visible in the Inspector by clicking their 
disclosure triangle.

2 Check the Program checkbox.

3 In the track’s header, double-click its icon to 
open the track’s object editor.

Double-click here.

You’ll find the JUNO-Gi’s tones and rhythms in the object editor.

 

In the JUNO-Gi Patch/Performance List, you can see that each tone 
and rhythm has an LSB value.

Disclosure triangle

The JUNO-Gi as Logic Pro’s Controller/Sound Module

Using the JUNO-Gi as Master MIDI Controller

Logic Pro is set by default to listen MIDI data on any 
channel so there’s nothing to set up. You can see Logic 
Pro “listening” to the JUNO-Gi by playing some notes 
and watching the activity monitor in the Logic Pro 
transport bar.

Setting Up a MIDI Track to Play a JUNO-Gi Tone or Rhythm

1 In the Arrange window, click the + button above the track list to 
create a new External MIDI track.

Make sure Open Library 
is checked, too.

Each of the JUNO-Gi’s 16 possible tones or rhythms is played by one 
of the 16 available MIDI channels. If you want each MIDI track to play 
its own sound, it has to be the only one using this MIDI channel.

2 In the opened Library pane, select JUNO-Gi library, and then the MIDI 
channel you want the MIDI track to use.

Here we’ve selected 
the JUNO-Gi’s 
Channel 1.

If you do want multiple MIDI tracks to use the same tone or rhythm, set 
them to use the same part.

If the JUNO-Gi’s in MIDI Controller mode, the Logic Pro track’s now 
ready to sequence using one of the JUNO-Gi’s tones or rhythms.

http://www.rolandus.com/products/productdetails.php?ProductId=1126&tab=support&skip=true
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Ableton Live and the JUNO-Gi

Setting Up Live

Selecting the JUNO-Gi as Your Audio Interface

1 From the Live menu, select Preferences... and click Audio along the 
left edge of the Preferences window to open the Audio tab.

2 From the Audio Input Device and Output Device popup menus, 
select JUNO-Gi 44.1kHz (2 In 2 Out).

Live’s sample rate is set by the JUNO-Gi.

Live has an easy-to-use system for setting the optimal buffer size, a 
key element in smooth audio-recording operations. To learn about it, 
see “Learn how to set up your audio hardware” in the Setup section of 
Live’s built-in Help pane.

You’ll find the tone in the Logic Pro bank that shares this number.

 

In addition, you’ll find JUNO-Gi rhythms in Bank 7.

4 Select the bank you want from the Bank popup menu.

 

5 Select the desired tone or rhythm from within that bank by clicking it 
in the object editor to highlight it.

6 Close the object editor window when you’re done.

You can also select sounds directly in the track’s Inspector pane, 
though it’s not as reliable a method as using the object editor.

You can create a project template with your favorite JUNO-Gi tones 
and rhythms already set up to save time when you begin a new project.



17

Setting Up an Audio Track for Recording From the JUNO-Gi

1 Create a new audio track or select an unused one.

By default, a new audio track is set to Ext. In and Inputs 1/2, so the 
JUNO-Gi’s outputs are automatically routed to the track without your 
having to do anything.

We’re using the JUNO-Gi’s stereo output here. If you prefer, 
you can record either the left or ride side of its stereo output 
as a mono track instead by selecting Input 1 or 2, respectively. 
With two mono tones panned left and right within the 
JUNO-Gi, this is a good way to simultaneously record them on separate 
tracks. It’s also a good way to record a mono track of live audio.

2 Set the track’s Monitor section to Off so you’re listening to the audio 
you’re recording directly through the JUNO-Gi instead of via Live’s 
outputs. This prevents any timing lag, or “latency.”

Here’s what your audio track’s 
controls should look like.

The JUNO-Gi as Live’s Controller/Sound Module

Using the JUNO-Gi as Master MIDI Controller

Since Live, by default, “listens” to all MIDI inputs on all channels automatically, 
there’s nothing you need to do—just play your JUNO-Gi, and Live’s MIDI-
aware tracks respond. 

Selecting the JUNO-Gi as a MIDI Controller

1 In the Preferences window, click the MIDI Sync tab.

2 In the MIDI Ports area, activate

• incoming MIDI—by clicking the Input: JUNO-Gi Track button so 
it lights and reads On.

• outgoing MIDI—by clicking the Output: JUNO-Gi Track button so 
it lights and reads On.

3 Close the Preferences window.

Using Live with the JUNO-Gi

The JUNO-Gi as Live’s Audio Interface

Listening to Live Through the JUNO-Gi

Once you’ve got the JUNO-Gi configured as Live’s audio interface, you can 
listen to Live

• through your speakers—by connecting the JUNO-Gi’s L/MONO and R 
OUTPUT jacks to your mixer, powered speakers, or amplifier.

• through headphones—by plugging your headphones into the
JUNO-Gi’s PHONES jack.

In both cases, the JUNO-Gi’s VOLUME knob controls your listening level.
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4 In the Notes area, you’ll find the

• Bank popup menu—that sets the Bank Select MSB value to be 
sent to the JUNO-Gi. Live uses an offset of 1 for this, so add 1 to 
the patch-performance list’s MSB value.

The Bank Select MSB for this 
tone is 87, so we’ve entered 88.

• Sub-Bank popup menu—that sets the Bank Select LSB value. Live 
also offsets the LSB, so add 1 to the listed LSB value as well.

The Bank Select LSB for this tone 
is 0, so we’ve entered 1.

• Program popup menu—that sets the Program Change value to 
be sent to the JUNO-Gi. (There’s no offset for this value.)

Here’s what it all looks like after we 
enter the Program Change value.

5 Press the Play button so Live sends the MIDI messages to the 
JUNO-Gi and selects your tone or rhythm.

6 To play the JUNO-Gi sound, click the track’s Arm button so it lights 
red.

Setting Up a MIDI Track to Use a JUNO-Gi Tone or Rhythm

1 In the Arrangement View create a new MIDI track or select one.

2 Click the MIDI To popup, and select JUNO-Gi.

 

3 Click the Channel popup just below “JUNO-Gi” and 
select the MIDI channel you want to use for the track’s 
JUNO-Gi tone or rhythm.

With the JUNO-G in MIDI Controller mode, you’re ready 
to sequence using a JUNO-Gi’s tone or rhythm.

Choosing the JUNO-Gi Tone or Rhythm You Want

You’ll need the JUNO-Gi tone and rhythm list as you select sounds. 
Click here to download a PDF of the JUNO-Gi Patch/Performance List.

1 Select the first measure of your MIDI track by dragging from left to 
right across it with your mouse in Arrangement View.

2 Select Insert MIDI Clip from the Create menu.

3 Double-click the clip to show its settings in the 
Clip View.

For our example, we’ll select St. Piano 1, which 
requires

• an MBS value—of 87,

• an LSB value—of 0, and

• a Program Change value—of 1.

Double-click here.

http://www.rolandus.com/products/productdetails.php?ProductId=1126&tab=support&skip=true
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After sequencing in Arrangement View, you can chop up your sequence 
into clips for use in Session view.

Why not create a live-set template with all of your favorite JUNO-Gi 
tones and rhythms already set up to save time when you begin a new 
project?

The End

We hope you’ve found this workshop helpful. Keep an eye out for 
other JUNO-Gi Workshop booklets available for downloading at 
www.RolandUS.com.

http://www.rolandus.com/products/productdetails.php?ProductId=1126&tab=support&skip=true
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